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WORKSHEET 1

MODULAR Ver. 2.1

CATEGORIES OF COMPUTERS

A. 	 Tick ( ) the correct option.
1.	 Which of these is a supercomputer?

a.	 PARAM      	 	 b.	 ICL 39	

c.	 PDP-11	 	 d.	 None of these	

2.	 Microwave is an example of ……………………. .

a.	 Supercomputer	 	 b.	 Handheld computer	

c.	 Embedded computer	 	 d.	 None of these	

3.	 Which of the following is a microcomputer?

a.	 Laptop	 	 b.	 IBM 4381	

c.	 PARAM	 	 d.	 None of these	

B.	 Identify following computers and write their names.

1. ……………………. 2. ……………………. 3. …………………….

C.	 Write ‘T’ for true and ‘F’ for false.
1.	 PARAM was India’s first supercomputer.			   …………….

2.	 Low-level language is very easy to understand.			   …………….

3.	 ICL 39 is a Microcomputer.					     …………….
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WORKSHEET 2

MODULAR Ver. 2.1

A.	 Guess who am I?

1.	 I am the main computer which provides data and other services to  
other computers in a network.					    …………….

2.	 My other name is Personal computer.			   …………….

3.	 You can wear me on your wrist.				    …………….

B.	 Answer the following questions:

1.	 What is an analog computer?

	 ………………………………………………………………………………………………

2.	 What is hybrid computer?

	 ………………………………………………………………………………………………

3.	 Name three handheld computers.

	 ………………………………………………………………………………………………

C.	 Write any two examples of the following:

1.	 Hybrid computer

	 ………………………………………………………………………………………………

2.	 Mainframe Computers

	 ………………………………………………………………………………………………

3.	 Embedded computers 

	 ………………………………………………………………………………………………
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WORKSHEET 1

MODULAR Ver. 2.1

WINDOWS 10

A.	 Tick ( ) the correct option.
1.	 Which of the following is not a feature of Windows 10?

a.	 Snap	 	 b.	 Flip	

c.	 Sneak	 	 d.	 None of these	

2	 Which of the following is a video format?

a.	 MOV	 	 b.	 MP3	

c.	 MP4	 	 d.	 Jpg	

3.	 Which of the following option is used to send a picture as an attachment?

a.	 E-mail	 	 b.	 Slide Show	

c.	 Share 	 	 d.	 None of these	

B.	 Match the following:

1.	 Show the preview	 a.	� Allows you to view your images as thumbnail, 
		 pane option 		  list, tiles, large icons, small icons and medium icons.

2.	 Change your view	 b.	 Opens a preview pane to view the preview of a 
selected menu 		  image.

3.	 Organize menu	 c.	� Provides various options to copy, delete and 
rename images.

C.	 Identify the following features of Windows 10 and write their names.

	 1. 	   ………………….…. 3. 	   ………………….….2. 	   ………………….….
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WORKSHEET 2

MODULAR Ver. 2.1

WINDOWS 10

A.	 Number the steps to start Windows Media Player.

1.	 Scroll down to W. 		

2.	 Start		

3.	 Windows Media Player		

B.	 Answer the following questions:

1.	 How do you see jump lists?

	 ………………………………………………………………………………………………	

2.	 What is Jump List?

	 ………………………………………………………………………………………………

3.	 What is the use of snap feature?

	 ………………………………………………………………………………………………

C.	 Write ‘T’ for true and ‘F’ for false.

1.		 CDs are connected to the computer using USB connectors.			   ………….

2.	 The Sneak feature of Windows 10 is used to arrange two windows  
side by side exactly to fill half the screen.			   ………….

3.	 Windows Media Player is an application software.			   ………….
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MODULAR Ver. 2.1

INTRODUCTION TO POWERPOINT 2016

A.	 Tick ( ) the correct option.

1.	 Which toolbar is located at the top left corner of the taskbar?

a.	 Status Bar	 	 b.	 Quick Access Toolbar	

c.	 Title Bar	 	 d.	 None of these	

2.	 Which type of files can be created in PowerPoint?

a.	 Presentation	 	 b.	 Document	

c.	 Letter	 	 d.	 Spreadsheet	

B.	 Label the following window.

C.	 Fill in the blanks using the hints given below:

	 Hints: Status bar, Slide Area, Text placeholder

1.	 	…………….…. displays the number of current slide.

2.	 …………….…. is used to enter text on the slide.

3.	 …………….….  is the area which displays a large view of the current slide.
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MODULAR Ver. 2.1

INTRODUCTION TO POWERPOINT 2016

A.	 Guess who am I?

1.	 I am the shortcut key to view slide show from beginning.			   ………….

2.	 I have commands like Print, Save, Open etc.			   ………….

3.	 I am a view which shows all the slides of presentation in a miniature version.	 ………….

B.	 Match the following:
1.	 View			   a.	 MS PowerPoint

2.	 Ribbon			   b.	 Normal

3.	 Application Software			   c.	 Multiple tabs

C.	 Answer the following questions:

1.		 What is the use of Notes pane?

	 ………………………………………………………………………………………………

2.	 Name any two views of a presentation.

	 ………………………………………………………………………………………………

3.	 What is a slide?

	 ………………………………………………………………………………………………

D.	 Label the steps to open a saved presentation.

To open a saved presentation, follow the given steps:

	  Click on Open.

	  Click on File tab to go to backstage view.

	  Browse and click on Open button

	  The Open dialog box will appear. Locate and select your presentation.

Chapter-3



Grade:          Teacher’s Signature: 

 

c
la

ss
 6

Name: 

Roll No: 

Class:  Section:  Date: 

WORKSHEET 1

MODULAR Ver. 2.1

WORKING WITH POWERPOINT 2016

A.	 Tick ( ) the correct option.
1.	 Which of these is a library of ready-made pictures and graphics?

a.	 ClipArt	 	 b.	 WordArt	

c.	 Animation	 	 d.	 None of these	

2.	 Arrangement of text, graphics, images, etc. in a slide is called …………………. .

a.	 Animation	 	 b.	 Slide Layout	

c.	 ClipArt	 	 d.	 None of these	

3.	 The view that shows the miniature version of the slides is …………………. .

a.	 Notes Page	 	 b.	 Outline View	

c.	 Slide Sorter View	 	 d.	 None of these	

B.	 Fill in the blanks using the words given below:
	 Hints: Rotate, Slide sorter, Saved pictures

1.	 PowerPoint allows us to …………………. a shape, text, picture and ClipArt in clockwise 
or anticlockwise direction.

2.	 MS PowerPoint lets you insert …………………. that you may have created or downloaded. 

3.	 The order of the slides can be changed in the …………………. view.

C.	 Label the following windows:

      

1.	 ………………………. 3.	 ……………………….2.	 ……………………….
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MODULAR Ver. 2.1

WORKING WITH POWERPOINT 2016

A.	 Write the use of following SmartArt diagrams:

1.	 Relationship 		  …………………………………

2.	 Matrix 		  …………………………………

3.	 Pyramid 		  …………………………………

4.	 Picture		  …………………………………

5.	 List		  …………………………………

B.	 Answer the following questions:

1.	 What do you mean by SmartArt? 

	 …………….….…………….….……………………….….…………….….…………….….

	 …………….….…………….….……………………….….…………….….…………….….

2.	 What is Slide layout? 

	 …………….….…………….….……………………….….…………….….…………….….

	 …………….….…………….….……………………….….…………….….…………….….

3.	 Write steps to insert a WordArt on the slide.

	 …………….….…………….….……………………….….…………….….…………….….

	 …………….….…………….….……………………….….…………….….…………….….
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MODULAR Ver. 2.1

ENHANCING A PRESENTATION

A.	 Label the components of the chart of the PowerPoint.

B.	 Tick ( ) the correct option.

1.	 Which tab is used to create a table in PowerPoint? 

a.	 Home	 	 b.	 Format	

c.	 Insert 	 	 d.	 None of these	

2.	 The intersection of a row and a column in a table is called a ………….. 

a.	 Cell	 	 b.	 Row	

c.	 Table 	 	 d.	 Column	

C.	 Answer the following questions:

1.	 Write the names of any three charts provided by PowerPoint. 

	 ………………………………………………………………………………………………

2.	 What is the use of the Table Styles? 

	 ………………………………………………………………………………………………
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ENHANCING A PRESENTATION

A.	 Fill in the blanks using the hints given below:

	 Hints: Shading, Insert, Axis Titles, Chart Layouts, Legend 

1.	 The Table option is present under the Tables group of the ……………………. tab.

2.	 ……………………. command is used to change the background of the table. 

3.	 Chart styles are listed in the ……………………. group of the Design tab. 

4.	 ……………………. is a key which shows the meaning of symbols and colours used in 
the chart. 

5.	 The ……………………. command is used to give titles of both x-axis and y-axis.

B.	 Write ‘T’ for true and ‘F’ for false.

1.	 We cannot give background colour in a table.� ………….

2.	 PowerPoint does not provide any tool to improve the appearance of a chart. �………….

3.	 Plot area of a chart is the rectangular area bounded by the two axis. � ………….

4.	 The bar chart displays the data in the form of long rectangular rods also
	 called bars. � ………….

5.	 You cannot align text in a table. � ………….

C.	 Match the following:

1.	 Legend	 a.	 Value axis

2.	 X-axis	 b.	 shows the meanings of symbols and colours

3.	 Y-axis	 c.	 includes all objects and elements in a chart

4.	 Chart Area	 d.	 Category axis
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MODULAR Ver. 2.1

ADVANCED FEATURES OF POWERPOINT 2016

A.	 Tick ( ) the correct option.

1.	 Slide transition can be defined as ………………. of one slide after another.

a.	 Movement	 	 b.	 Deletion	

c.	 Creation	 	 d.	 None of these	

2.	 Animation is used to hold the ………………. of audience.

a.	 attendance	 	 b.	 absence	

c.	 attention	 	 d.	 feelings	

3.	 Which button can be used to move from one slide to another and play media files?

a.	 Action	 	 b.	 Play	

c.	 Close	 	 d.	 None of these	

B.	 Identify the following Dialog boxes:

1.	 ……………………….…….…….……. 1.	 ……………………….…….…….…….
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ADVANCED FEATURES OF POWERPOINT 2016

A.	 Fill in the blanks using the hints given below:

Hints: Insert video, Slide, Shapes

1.	 When we click on the Video command from the Insert tab, the ………………… dialog 
appear.

2.	 The Object command from the ………………… group under the Insert tab is used to 
import data from outside of the PowerPoint.

3.	 The ………………… command is used to add an action button on the slide.

B. 	 Answer the following questions:

1.	 What is the use of adding animations in a presentation?

	 ………………………………………………………………………………………………

	 ………………………………………………………………………………………………

2.	 What is transition? Name two transition effects.

	 ………………………………………………………………………………………………

	 ………………………………………………………………………………………………

3.	 Write the steps to reorder the animations.	

	 ………………………………………………………………………………………………

	 ………………………………………………………………………………………………
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INTERNET AND E-MAIL

A.	 Read the clues and answer the following:

1.	 It is an address of a web page over the Internet.

	 ………………………………………………………………………………….……………

2.	 It is an Internet host computer that often store thousands of individual web pages.

	 ………………………………………………………………………………….……………

3.	 It is a system of interconnected networks.

	 ………………………………………………………………………………….……………

4.	 It is a collection of related web pages.

	 ………………………………………………………………………………….……………

5.	 It is a software application designed to find hypertext documents on the web and then 
open the documents on the user’s computer.

	 ………………………………………………………………………………….……………

B.	 Circle the correct option.

1.	 (Internet / E-mail) is a huge, cooperative community with no central ownership.

2.	 The seeds of the Internet were planted in (1959 / 1969).

3.	 (HTTP / WWW) is a large information system where you can surf and get information.

4.	 A collection of related pages is called (website / web browser).

5.	 A (web browser / hyperlink) is simply a part of the web page that is linked to a URL.

C.	 Name the different parts of the following email:

1.  ........................... 2.  ...........................
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INTERNET AND E-MAIL

A.	 Write the full forms of the following:

1.	 ARPA - ……………………………………………………………………………………..…

2. 	 HTTP - ………………………………………………………………………………………

3.	 WWW - ………………………………………………………………………………………

4.	 NCSA - ………………………………………………………………………………………

5.	 URL - …………………………………………………………………………………………

B.	 Tick ( ) the correct option.

1.	 E-mail can be defined as the process of exchanging ........................... electronically. 

a.	 Hardware 	 	 b.	 Instructions	

c.	 Messages 	 	 d.	 Information	

2.	 Which of the following fields is not available while writing a new email in Gmail?

a.	 To	 	 b.	 Cc	

c.	 Subject 	 	 d.	 New Message	

3.	 Which of these is used to show Sleeping expression emoticon?

a.	 (-_-)zzz	 	 b.	 (=_=)	

c.	 :$	 	 d.	 None of these	

C.	 Match the following:

1.	 Internet	 a.	 Software application

2.	 Collection of related pages	 b.	 Web address of a web page

3.	 Web browser	 c.	 A large computer network

4.	 URL	 d.	 Website
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A.	 Tick ( ) the correct option.
1. 	 Which one of the following is not an arithmetic operator used in Python? 

	 a.	 Addition 	 	 b.	 Multiplication 	

	 c.	 Exponentiation	 	 d.	 Parentheses	

2. 	 Which of the following symbol(s) is/are used for comments in Python? 

	 a.	 // 	 	 b.	 ‘’	

	  c.	 /**/ 	 	 d.	 #	

3. 	 The language understood by the computer is ……………………. .

	 a.	 Assembly language 	 	 b.	 Machine language 	

	 c.	 High-level language 	 	 d.	 4GL	

B.	 Write ‘T’ for true and ‘F’ for false.
1.	 The print() function allows to display output on the screen while a � …………. 

program executes.  

2.	 Machine language is also known as first generation language (1GL). � …………. 

3.	 The relational operators are used primarily in the expression evaluation to � …………. 
make a decision. �

C. 	 What will be the output of the following program?
1. 	 p, q, r = 10, 20, 30 print(p, q, r) 

	 ……………………………………………………………………………………………… 

	 ………………………………………………………………………………………………

2. 	 a = 4.5 b = 2 print (a//b) 

	 ………………………………………………………………………………………………

	 ………………………………………………………………………………………………

INTRODUCTION TO PROGRAMMING
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A.	 Fill in the blanks using the hints given below:

Hints: Instructions, Assembler, Interactive, Guido van Rossum, Digit
1.	 Python was developed by …………………. . 

2.	 In …………………. mode, we type one command at a time. 

3.	 A variable name cannot start with a …………………. .

4.	 A computer language is the means by which …………………. are transmitted to the 
computer.

5.	 An …………………. is a program used to translate assembly language into machine 
language.

B.	 Answer the following questions:
1. 	 Define the term data types.

	 ………………………………………………………………………………………

2. 	 What is the use of variables in Python?

	 ………………………………………………………………………………………

3. 	 Define computer language.

	 ………………………………………………………………………………………

C. 	 Identify the components of Python IDLE window and write down the names in the 
given boxes.

INTRODUCTION TO PROGRAMMING
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